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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in June 2021

Sector Indices vs HSI / HSCEI

Index Name

HS Mainland
Oil & Gas Index

HSI -1.1% .

HSCEI

HS Mainland
Properties Index

HS Mainland

-7.3%

CES120 vs China Theme Indices

Index Name

CSI 300 Index

HSCEI

CES120 Index

FTSE A50 Index

-4.2%

-2.3%

1]

I

% Change % Change
Equity Index Futures Access Codes
HS Mainland HS Mainland

Vendor HS Mainland Banks Properties Oil & Gas CES 120 HSI HSCEI
Bloomberg BMWA PPTA OGIA CESA HIA HCA

Refinitiv 0#HMBI: O#HMPI: 0#HMOI: O#HCHH: 0#HSI: O#HCEL:

WIND MBIF MPIF MOIF CHHF HSIF HHIF

ET Net MBI MPI MOI CHH HSI HHI

Data Source: Bloomberg
As at 30 June 2021

Information for reference only
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Equity Index Futures & Options

Hang Seng Index (HSI) Futures & Options

HSI Products

(2021 vs 2020)

HSI Futures

Mini-HSI Futures

HSI Options

Mini-HSI Options
HSI Volatility

Index Futures

HSI Dividend
Point Index
Futures

Data Source: HKEX

143,800 (-14%)

104,081 (-7%)

28,099 (-29%)

11,737 (-13%)

0 (-100%)

53 (-48%)

* Ol compared to previous year-end
Information for reference onlv

As at 30 June 2021

X

104,482 (-19%)

11,221 (-35%)

94,672 (-42%)

11,673 (+35%)

0()

3,631 (-6%)
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

L Includes the largest and most ‘000
Index Description bauid s listedlin Hong K ( ) 130
iquid stocks listed in Hong Kong 30 1 ——HS| ——VHSI - 22 | e S IndlEX ——— Tencent
Index Level 28,827.95 (As at 30 Jun 2021) HSBC —AA
20 120 { ——CCB ~— China Mobile
Index Volatility (30-Day Historical) | 22.7 29
110 -
Index Avg. Day High-Low Range 268.99 (Jun 2021) L 18
. 100 -
HSCE! Correlation (2021) 0.954 28 -
- 16 90 -
Hang Seng Index Futures 27 . . 14 80
Apr21  May-21  Jun-21 Apr-21 May-21 Jun-21
Contract Multiplier HK$50
Notional Value (1 Contract) HK$1.44Mn (As at 30 Jun 2021) Distribution of HSI Index Options Ol in Month-end
Call Put

Transaction Cost* 36.8

. 36.8 S 348
Stamp Duty NA 8 34.8 S38

c 328 308

5 (&S] )

Trading Fee HK$10 / contract 3 ggg X 28.8

€ %6 ©26.8
SFC Levy HK$0.54 / contract L ong —m—m— % 24.8

B g = x 228
Commission Rate Negotiable %3 208 g 20.8 —

E 19.4 =194 =
Margin as of 30 Jun 2021 HK$92,050 18.4 18.4

14.0 T 14.0 T r )
0 2 4 0 2 4 6
Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 June 2021
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Products AD\ HSCEI Futures (YoY) HSCEI Options (YoY)

(2021 VS 2020) Average Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
160,000 - == ADV (L-Axis) r 600,000 120,000 1 ADV (L-Axis) r 2,800,000
Open Interest (R-Axig) Open Interest (R-Axis)
L . - 2,400,000
HSCEI Futures 120,734 (-17%) 286,531 (-1%) 120,000 - 500,000 100,000
- 400,000 80,000 - 2,000,000
- 1,600,000
80,000 - - 300,000 60,000 -
oo - 1,200,000
Mini HSCEI - 1
14,715 (-19%) 3,953 (-6%) 40,000 200,000 40,000 - 800,000
Futures - 100,000 20,000 - - 400,000
0 - 0 0 LI B B B B B B B B B R | 0
) O N O v A 9O X
. S PSS S S
HSCEI Options 42,911 (-48%) 1,202,828 (-20%) v
HSCEI Futures (MoM) HSCEI Options (MoM)

R Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
Mini HSCEI 1.400 (-38%) 2 499 (-28%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
Options 220,000 - s ADV (L-Axis) - 600,000 150,000 - ADV (L-Axis) - 4,000,000

. Open Interest (R-Axis) - 500,000 Open Interest (R-Axis)
HSCEI Dividend 165,000 - 4 - 3,000,000
Point Index 1,491 (-17%) 77,742 (+48%) L1 I 00,000 100,000 1
Futures 110,000 | I B )4 300,000 - 2,000,000
- 200,000 50,000 -
55,000 - 1,000,000
- 100,000
0 ] - 0 0 > O > 0
= oaw cas s >c
338858585285
2020 2021

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 30 June 2021
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI HSCEI & Top 5 Constituents

Comprises the largest and

Index Description
P most liquid H shares 102

==HSI| ==——HSCEI 1201 ——psce Ping An
Index Level 10,663.39 (As at 30 Jun 2021) ——ICBC  ——CCB

100 A BOC ——China Life
Index Volatility (30-Day Historical) | 23.7 110 1
Index Avg. Day High-Low Range 108.81 (Jun 2021) 9% 1 100
Correlation with HSI, CES120 (2021)| 0.954,0.877 96 g

) ) 90
Correlation with CSI300, FTSE A50 0.654,0.635 4 . . . .
(A=) Q& Q Q Q& Q
N NN L Apr-21 May-21 Jun-21

Contract Multiplier HK$50 Distribution of HSCEI Index Options Ol in Month-end
Notional Value (1 Contract) HK$0.53Mn (As at 30 Jun 2021) Call 990 Put
22.0 16.8
1681 81438
glas e S138
Transaction Cost* s138 = 0128
o128 2118
o x 11.
Stamp Dut N/A o118
S £ 108 £108
Q = .
Trading Fee HK$3.5 / contract = gg 72 gg
S 78 $ 78
x I T
SFC Levy HK$0.54 / contract 8 62 £ 6.2
£ 44 4.4 —
Commission Rate Negotiable 2.0 | T S 2.0 " r r s
0 20 40 0 20 40 60 80
Margin as of 30 Jun 2021 HK$34,500 Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 June 2021
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Weekly HSI & HSCEI Options Performance

Contract Multiplier HK$50 v
olume
o . Akuna, Eclipse, I-Access, IMC, Maven,  (No. of Contracts)
Liquidity Providers .
Optiver 18,000 - .
® Weekly HSI Options
: 15,000 kly HSCEI Opgions
Transaction Cost* 12,000 -
Stamp Duty N/A 9,000 -
Trading Fee HK$10 / contract 6,000 -
SFC Levy HK$0.54 / contract 3,000 1
. . 0 -
Commission Rate Negotiable © © © © © © © © © © © © © © © © © O © © ©
SRBSNBS 3852 N0I8RRS
i Volume
Weekly HSCEI Options e ontracts) |
Contract Multiplier HK$50 12,000 - = \Neekly HSI & HSCEI Options Call
. ==\Neekly HSI & HSCEI Options Put
Liquidity Providers Akl_ma, Eclipse, I-Access, IMC, Mawen, 10,000 -
Optiver
8,000 -
6,000 -
1 *
Transaction Cost 4,000 -
Stamp Duty N/A 2.000 -
Trading Fee HK$3.5 / contract 0 —
© OO OOOOOOYHO0OO0OOOOOOLOO
SFC Levy HK$0.54 / contract T ABINDTIOSOAINONDBINDI OB DO
= NN NN ANNANM
Commission Rate Negotiable

An investment tool to manage short term event risk

Data Source: HKEX

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 June 2021
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2021 vs 2020) _— No. of Single Stock Derivatives

Stock Futures 11,160 (+143%) 38,230 (+66%) Single Stock Futures
Stock Options 687,473 (+31%) 9,674,982 (+8%) Single Stock Options 110
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
12,000 mm— ADV (L-Axis) r 45,000 800,000 - ADV (L-Axis) - 12,000,000 S/ ENTIES
10,000 - Open Interest (R-Axis) : ggggg 600,000 Open Interest (R-AXxis) .| 10,000,000
8,000 - 30,000 ' - 8,000,000 * Products
6,000 " 25,000 460000 - ~ 6,000,000 > 3 A-shares ETFs futures contracts
[ 20,000 > Total 83 stock futures contracts
4,000 - 15,000 - 4,000,000
- 10,000 200.000 - - 2,000,000
2,000 L 5.000 ,000,
O L 0 0 T T T T T T T T T T T T O
O N » O A L0 N
L° N AN N N\ N N
B R S S S S N
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts) » 3 A-shares ETFs options contracts
_ mmmmm ADV (L-AXis) _ 1,000,000 - ADV (L-Axis) - 16,000,000 A
16,000 Open tereat (R-axis) | 43:000 Open nterest (R-Axis) > Total 110 stock options contracts
14,000 1 20000 800,000
12,000 - [ 35,000 ’ - 12000000 . Market Makers (MMs)
10,000 - - 30,000 600,000 ’\/\/\—\ > 3 types of market makers (PMM/ CQMM/
8,000 - - 25,000 - 8,000,000 typ
] - 20,000 400,000 - QRMM)
6,000 - 15,000 . . .
4,000 - - 10000 200.000 - - 4,000,000 » CQMM to provide 50 series continuous
2,000 - - 5,000 ’ quotations
01 0 0 > O > 0
—oa*= >0 c [N = S o990 c el c
333858888285 338828885285
2020 2021 2020 | 2021

Data Source: HKEX

* Ol compared to previous year-end
Information for reference onlv

As at 30 June 2021
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Hang Seng TECH Index Futures and Options Performance

Hang Seng TECH Index Open Interest (as of 30 June 2021)

Tracks the largest technology companies
Index Description
listed in Hong Kong Open Interest
(No. of Contracts)
30,000 -
Hang Seng TECH Index Futures & Options 25,000 -
Contract Multiplier HK$50 per index point 20.000 -
Notional Value (1 Contract) HK$408K (As at 30 June 2021) 15.000 -
No. of Liquidity Providers Futures: 4; Options: 6 10.000 -
5,000 - I
Transaction Cost* 0 |- .
Stam p Duty N/A 3 3 B ‘ S g 2_ = =
Trading Fee HK$5.00 / contract < o i - = i
SFC Levy HK$0.54 / contract 2020 | 2021 |
Average Daily Volume (as of June 2021)
ADV
(No. of Contracts)
12,000 -
10,000 -
8,000 -
6,000 -
4,000 - I
2,000 -
o m W
> 8] c o = = > c
© S
Z a 5 ‘ ¢ = < £ A3
2020 | 2021

Providing investors with a tool to manage their risk exposure

; . Volume and Open Interest are Incubating
to Hong Kong-listed technology companies

Data Source: HKEX

* Exclude commission fees

Information for reference onlv

As at 30 June 2021
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MSCI Asia and Emerging Market Index Futures Performance

representation 38 DM and EM countries and

Index Description ; o Open Interest
regional indices (No. of Contracts)
100,000 -
MSCI Asia and Emerging Market Index Futures 80,000 -
Contract Multiplier Average US$40 60,000 -
Notional Value (1 Contract) Average US$52K (As at 30 June 2021)
No. of Liquidity Providers 14 40,000 1
20,000 -
Transaction Cost* 0 -
Stamp Duty N/A
Trading Fee US$0.6-US$1.0 / contract | |
SFC Levy US$0.07 / contract 2020 2021
Average Daily Volume (As of June 2021)
ADV
(No. of Contracts)
10,000 -
8,000
6,000
4,000
2,000

0

2020 2021

HKEX with the broadest suite of MSCI derivatives products

. . . Volume and Open Interest continue to growth
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 30 June 2021
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

MSCI AxJ

representation 2 DM countries (excl. Japan)

Index Description . )
and 9 EM countries in Asia

Index Level 677.65 (As at 30 June 2021)
Index Volatility (30-Day Historical) | 21.5

Index Avg. Day High-Low Range 4.09 (June 2021)

HSI Correlation (2021) 0.875

HSCEI Correlation (2021) 0.866

Contract Multiplier US$100

Notional Value (1 Contract) US$68K (As at 30 June 2021)
Avg. Quote Size US$0.34Mn (5 Contracts)
Avg. Bid-Ask Trading Spread 1.1 index points (June 2021)
Liquidity Providers Flow and 11 banks

Stam p Duty N/A

Trading Fee US$0.5 / contract

SFC Levy US$0.07 / contract

Margin as of 30 Jun 2021 US$2,730

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 30 June 2021

X

Open Interest (30 June 2021)

Open Interest
(No. of Contracts)

10,000 -
8,000
6,000
4,000
2,000

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

120 ~

0

MSCIAXJ s MSCI China MSCI HK

MSCISG =~ e MSCl India o MSCI Indonesia
----------------- MSCI Korea - MSCI Malaysia MSCI Pakistan
---------------- MSCI Philippines - MSCI Taiwan MSCI Thailand

90
Apr-2021 May-2021 Jun-2021

MSCI AxJ is a well-established benchmark representing Asia
regional (excluding Japan) equity market performance

12



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2021)

HSCEI Correlation (2021)

10 largest and most representative
HKEX-listed mainland banks stocks

2,898.27 (As at 30 June 2021)
24.6

21.21 (June 2021)

0.605

0.581

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 30 Jun 2021

HK$50

HK$0.14Mn (As at 30 June 2021)
HK$0.72Mn (5 Contracts)

64.9 index points (June 2021)

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$7,570

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv
As at 30 June 2021

X

5-Min Avg. Bid-Ask Spreads (30 June 2021)

HSMBI Futures
CEB Bank 6818.HK

Bank of China 3988.HK
Bankcomm 3328.HK
CITIC Bank 998.HK
Minsheng Bank 1988.HK
PSBC 1658.HK

CM Bank 3968.HK

1.71%

ABC 1288.HK

CBC 1398.HK

CCB 939.HK

Index & Constituents 3-Month Performance (Rebased to 100)

120 -
115 A
110 -
105 +
100 -
95 ~
90 -
85 -

——HSMBI
ICBC (1398.HK)
—— ABC (1288.HK)

——CCB (939.HK)
BOC (3988.HK)

80
Apr-2021

May-2021 Jun-2021
HSMBI Futures can be used for hedging

13



Hang Seng Mainland Oil & Gas Index Futures Performance

Hang Seng Mainland Oil & Gas Index (HSMOGI) 5-Min Avg. Bid-Ask Spreads (30 June 2021)

7 largest and most representative

Index Description
P HKEX-listed mainland oil & gas stocks HSMOGI Futures

2.25%

Index Level 1,291.28 (As at 30 June 2021)

Kunlun Energy 135.HK
Index Volatility (30-Day Historical) | 40.8

. PetroChina 857.HK
Index Avg. Day High-Low Range 17.74 (June 2021)

HSI Correlation (2021) 0.514 China Qilfield 2883.HK

HSCHE lati 2021 A7
SCEl Correlation (2021) 0.478 Sinopec Corp 386.HK

Hang Seng Mainland Oil & Gas Index Futures CNOOC 883HK

Contract Multiplier HK$50
Notional Value (1 Contract) HK$65K (As at 30 June 2021)
Avg. Quote Size HK$0.32Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread 29.8 index points (June 2021) 150 - e HSMOGI —— PetroChina (857.HK)
S ; —— CNOOC (883.HK) Sinopec Corp (386.HK)
140 A
Liquidity Providers N/A Kunlun Energy (135.HK)

130
120

Transaction Cost*
110 Z o M

>

P
Stamp Duty N/A 100 _»_“M
Trading Fee HK$2 / contract 90 -
SFC Levy HK$0.54 / contract 80 1
. 70 T T )
Margln as of 30 Jun 2021 HK$4,480 Apr-2021 May'2021 Jun-2021
Futures contracts have relatively lower transaction costs HSMOGI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 June 2021
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Hang Seng Mainland Properties Index Futures Performance

Hang Seng Mainland Properties Index (HSMPI)

10 largest and most representative

Index Description ) ) .
HKEX-listed mainland properties stocks

Index Level 5,970.70 (As at 30 June 2021)
Index Volatility (30-Day Historical) | 32.4

Index Avg. Day High-Low Range 63.52 (June 2021)
HSI Correlation (2021) 0.499

HSCEIl Correlation (2021) 0.533

Hang Seng Mainland Properties Index Futures

Contract Multiplier HK$50

Notional Value (1 Contract) HK$0.30Mn (As at 30 June 2021)

Avg. Quote Size HK$1.5Mn (5 Contracts)

Avg. Bid-Ask Trading Spread 95.3 index points (June 2021)

Liquidity Providers N/A

Transaction Cost*

Stamp Duty N/A
Trading Fee HK$2 / contract
SFC Levy HK$0.54 / contract

Margin as of 30 Jun 2021 HK$19,270

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 June 2021

X

5-Min Avg. Bid-Ask Spreads (30 June 2021)

Fullshare 607.HK 1.21%
Kerry Ppt 683.HK
Shimao Property 813.HK
China Res Land 1109.HK
Longfor PPT 960.HK
Sino-Ocean Gp 3377.HK
Evergrande 3333.HK
China Vanke 2202.HK
Country Garden 2007.HK
HSMPI Futures

China Overseas 688.HK

Index & Constituents 3-Month Performance (Rebased to 100)

115 - ==HSMPI Evergrande (3333.HK)
China Overseas (688.HK) Country Garden (2007.HK)
China Res Land (1109.HK)
105 -
— . P4 S
95 -
85 -
75
65 T T )
Apr-2021 May-2021 Jun-2021

HSMPI Futures can be used for hedging

15



CES120 Index Futures Performance

CES120 Index 5-Min Avg. Bid-Ask Spreads (30 June 2021)
. 80 A-Shares and 40 HK-listed Mainland
Index Description . . .
China H-shares, P-chips, and red chips
CES120 Futures 1.02%
Index Level 8,326.78 (As at 30 June 2021)
Index Volatility (30-Day Historical) | 21.0

XiShares A50 ETF (2823.HK) - 0.15%
Index Avg. Day High-Low Range 83.28 (June 2021)

CSI300 Correlation (2021) 0.903
CSOP FTSE AS0 ETF (2822.HK) I 0.07%
FTSE A50 Correlation (2021) 0.902
CES120 Index Futures ChinaAMC CSI300 ETF (3188.HK) F 0.05%
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.42Mn (As at 30 June 2021)
Average Quote Size HK$2.08Mn (5 Contracts) CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

Average Bid-Ask Trading Spread| 85.1 index points (June 2021)

115 e CES120 Index Tencent ccB
Liquidity Providers N/A Ping An ——— China Mobile
105 -
Stamp Duty N/A > X
Trading Fee HK$5 / contract 85 -
SFC Levy HK$0.54 / contract
Margin as of 30 Jun 2021 HK$20,640 7ASpr-2021 May'_2021 JUn-2021
Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 June 2021
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Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information ~ HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI China ia [MSCI EM Asia MSCI EM MSCIEM ex |MSCIEMex |MSCIEM
. Free NTR i ex Korea NTR [MSCI EM Asia [EMEA NTR China NTR Korea NTR LatAm NTR
Information [NTR (USD) Free (USD) (USD) Index (USD) Index  [NTR (USD) (USD) Index  |[(USD) Index |(USD) Index |(USD) Index
Vendor Index Futures |Index Futures |[Futures Futures Index Futures |Futures Futures Futures Futures
Bloomberg HKCA Index HMSA Index  HJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index  HQIA Index HQYA Index
Refinitiv 0#HMAN: 0#HMCU: 0#HMCN: 0#HMAC: 0#HMAK: O#HEAN: 0#HMEE: 0#HMXC: 0#HMXK: O0#HMEL:
WIND MANF.HK MCNF.HK EANF.HK

MSCI Hong MSCI MSCI
. Kong NTR MSCI India MSCI India Indonesia Indonesia NTR|MSCI Japan  |MSCl Japan [MSCI Japan
Information (USD) Index  |(USD) Index |NTR (USD) Index (USD) |(USD) Index [(JPY) Index NTR (JPY) NTR (USD)
Vendor Futures Futures Index Futures |Futures Futures Futures Index Futures |Index Futures
Bloomberg HMPA Index  HMOA Index  HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index  HQBA Index  HJCA Index
Refinitiv O#HMEM: O#HEMN: O#HMHN: O#HMDA: O#HMIN: 0#HMID: 0#HMDN: O#HMJP: O#HMJJ: 0#HMJU:
WIND MINF.HK MDNF.HK MJUF.HK

MSCI
MSCI New MSCI Pacific MSCI MSCI Singapore MSCI
: MSCI Malaysia [MSCI Malaysia |Zealand NTR [ex Japan NTR |[MSCI Pacific |Philippines ilippi Singapore Free NTR Singapore

Information [USD) Index |NTR (USD) (USD) Index  |(USD) Index |NTR (USD) (USD) Index Free (SGD) (USD) Index  |NTR (USD)

Vendor Futures Index Futures |Futures Futures Index Futures |Futures Index Futures |Index Futures |Futures Index Futures
Bloomberg HMYA Index HKEA Index HOPA Index HRPA Index HRBA Index  HNSA Index HLEA Index HKOA Index HOBA Index HKPA Index
Refinitiv 0#HMMY: 0#HMMN: 0#HMNZ: 0#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: 0#HMSG: 0#HMGN: O#HMSN:
WIND MMNF.HK

MSCI Taiwan
: MSCI Taiwan [MSCI Taiwan |25/50 NTR MSCI Taiwan [MSCI Thailand |MSCI Thailand [MSCI Vietnam [MSCI Vietnam
Information [USD) Index  [25/50 (USD)  |(USD) Index  |NTR (USD) (USD) Index  [NTR (USD) (USD) Index  [NTR (USD)
Vendor Futures Index Futures |Futures Index Futures |Futures Index Futures |Futures Index Futures
Bloomberg HJAA Index HRCA Index HRDA Index HJBA Index HMTA Index HKDA Index HNTA Index HKSA Index
Refinitiv O#HMTW: O#HTWP: O#HTWN: O#HMWN: O#HMTH: O#HMTN: O#HMVT: O#HMVN:
WIND MTWFE.HK MWNF.HK MTNF.HK

Data Source: HKEX

X ’



Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X

19



Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Mainland Banks
Index

Information Vendor

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Mainland Banks
Index

Information Vendor

East Money HSMBI
Hexin Flush Financial

Pobo Financial

Qianlong 999905
Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
O0#HMBI:

Mainland Banks
Index Futures

MBI
MBIC
MBI+Month+Ye
ar

209

MBIF+yymm-+H
K

Mainland Mainland
Properties Properties Index
Index Futures
221425
=0200800.HK MPI/16K.HF
837451 870810
MSMPI Index PPTA Index
MPI
MPR MPI
MSMPI MPI
SEHK.HHSMPI P11224
MPImy
.HSMPI O#HMPI:
Mainland Mainland
Properties Index | Properties Index
Futures
HSMPI MPI
MPIC

MPI+Month+Year
999902 209

HSMPI MPIF+yymm-+HK

Mainland Oil
& Gas Index

=0201000.HK
837451
HSMOGI Index

MOG

MOGI

SEHK.HHSMO
Gl

.HSMOGI

Mainland Oil
& Gas Index

HSMOGI

999903

HSMOGI

Mainland Oil &
Gas Index
Futures

221415
MOI/16K.HF
870808
OGIA Index

MOl
MOl
MOl

P11222

MOImy
0#HMOI:

Mainland QOil &

Gas Index

Futures

MOI
MOIC
MOI+Month+Ye
ar

209

MOIF+yymm+H
K
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. i CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



